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Interoperability Guide

Integrating the PhoneEasy IP Console 
with the NetVanta 7100 and NetVanta BCS 

This interoperability guide describes how to configure the NetVanta 7100 for 
use with AdvaTel PhoneEasy IP Console software in both standalone 
NetVanta 7100 and NetVanta Business Communications System (BCS) 
environments. This guide contains information about how to configure settings 
on the NetVanta 7100 using the ADTRAN Operating System (AOS) web-based 
graphical user interface (GUI) and command line interface (CLI), as well as 
installing and configuring PhoneEasy IP Console software for use with the 
NetVanta 7100 and NetVanta BCS. In addition, this guide contains an advanced 
configuration section and a best practices section, which provide additional 
information for optimizing the integration.

This guide consists of the following sections:

• Overview on page 2
• Equipment and Versions on page 2
• Supported Features and Exceptions on page 2
• Setting the SIP Server Address in PhoneEasy IP Console on page 4
• Create and Configure a Status Group on the NetVanta 7100 on page 5
• Configure the Status Group in the PhoneEasy IP Console software on 

page 11
• Configure Optional Status Group Settings on page 11
• Special Configurations for NetVanta BCS on page 13
• Optional. Advanced Configurations on page 14
• Operating the PhoneEasy IP Console on page 16
• Integration Best Practices on page 18
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Overview
AdvaTel’s PhoneEasy IP Console software functions as a software-based call attendant, providing a variety 
of options for managing incoming calls on ADTRAN’s NetVanta 7100 and the NetVanta BCS. 

Several steps are required to configure both the software and the NetVanta 7100 hardware to achieve full 
functionality:

1. Set the Session Initiation Protocol (SIP) Server address to the virtual local area network (VLAN) 1 
Internet Protocol (IP) address of the NetVanta 7100 in the PhoneEasy IP Console software.

2. Create and configure a Status Group on the NetVanta 7100.
3. Configure a corresponding Status Group in the PhoneEasy IP Console software.
4. Configure the optional Status group settings on the NetVanta 7100.

Equipment and Versions
The following table outlines the equipment and software/firmware versions used during verification testing 
between the PhoneEasy IP Console and the NetVanta 7100 (standalone)/NetVanta BCS:

Product Version

NetVanta 7100 R10.8

NetVanta UC Server 5.4.1.8202

AdvaTel PhoneEasy IP Console 2.1.0.3888 PETE

Supported Features and Exceptions
The following sections provide information on the feature verification performed and limitations 
discovered during interoperability verification. The features listed in the Supported Features section below 
are the features verified to function with the testing equipment. These are the only features you can expect 
to function with the configuration provided in this guide.

Supported Features

The following features were tested and are supported by the PhoneEasy IP Console integration with both 
the NetVanta 7100 (standalone) and NetVanta BCS: 

• Answering, placing, holding, and resuming calls
• Transferring calls (internal/external) with drag and drop 
• Attended transferring calls (internal/external) with drag and drop 
• Direct transferring calls to voicemail

This guide only describes configuration of phone interoperability between the 
NetVanta 7100 and the AdvaTel PhoneEasy IP Console software. For information 
concerning any other features of the PhoneEasy IP Console software, such as Microsoft 
Outlook integration, refer to the appropriate AdvaTel documentation.
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• Parking and picking up calls with busy lamp field (BLF) status of park zones 
• Directed and group call pickup 
• Paging and zone paging 
• Adding speed dials 
• Monitoring user presence/status
• Monitoring park zone status 
• Creating user-defined groups for monitoring 
• Verifying user status by color and icon (for example: idle, ringing, on a call, DND, forwarded, direct 

transfer to voicemail, and out of service). 
• Searching for contacts
• Single-click answering of incoming calls 
• Quickly distinguishing different states of extension and calls by color
• Dialing using a single click
• Pop/toast for incoming calls, with limited call control options 
• Hovering over/right clicking options to show detailed information and actions for calls and users 
• Message waiting indicator (MWI) - voicemail access 
• Password protecting the application at launch time 
• Placing PhoneEasy IP Console in a ring group with a hardphone
• Forwarding all incoming calls to voicemail 
• Forwarding all incoming calls to another number 
• Ringing call pickup 
• Scheduling calls to contacts based on date and time. 
• Stacking calls
• Logging calls
• Conferencing calls

The following features were tested and are supported by the PhoneEasy IP Console integration with 
NetVanta BCS:

• Centralized voicemail operations using the NetVanta Unified Communications (UC) Server 
• Transferring to NetVanta UC Server voicemail
• Transferring to and from NetVanta UC Server application services and auto attendants
• Forwarding all incoming calls to NetVanta UC Server voicemail
• Audio conference bridging

Limitations

The PhoneEasy IP Console integration with either the NetVanta 7100 or NetVanta BCS has the following 
limitations:

• Only six simultaneous active calls can be handled by the PhoneEasy IP Console.
• Conference calls are limited to four parties, including the operator.
• A maximum of 32 BLFs can be monitored at a time from within a status group.
• The PhoneEasy IP Console can only monitor one status group.
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• The PhoneEasy IP Console can only register with one NetVanta 7100 at a time.
• Display skin and language customization options are not available on the PhoneEasy IP Console. 

However, additional columns for contact information can be added.
• The PhoneEasy IP Console internal directory and BLFs are not automatically populated from the 

NetVanta 7100 and must be manually configured. 
• The PhoneEasy IP Console cannot use an adjunct hardphone; however, a hardphone can be placed in a 

ring group with the PhoneEasy IP Console so that incoming calls to the PhoneEasy IP Console can be 
answered using the hardphone.

Setting the SIP Server Address in PhoneEasy IP Console
When installing the PhoneEasy IP Console software the Domain field must be configured correctly in 
order to function with the NetVanta 7100. Instead of using a domain server address, the field should be set 
to the VLAN 1 IP address of the NetVanta 7100.

Use the PhoneEasy IP Console Setup Wizard to install the software. 

Upon completion of the Setup Wizard the Configuration Manager Wizard will start automatically. The 
Configuration Manager Wizard requires the user to enter data specific to their phone and network.

On the SIP Credentials menu, set the Domain field to the VLAN 1 IP address as shown in Figure 1.

Figure 1.  SIP Credentials Menu

Setting the domain value in the PhoneEasy IP Console software to the VLAN 1 IP address 
requires that the PC be connected to VLAN 1. By default, on the NetVanta 7100 PCs are on 
VLAN 1 and IP phones are on VLAN 2.
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If the PhoneEasy IP Console software is already installed, the Domain field can be accessed in the 
software under SIP Settings by navigating to Tools > Options in the top menu bar as shown in Figure 2.

Figure 2.  SIP Settings Menu

Create and Configure a Status Group on the NetVanta 7100
A status group is a feature of the NetVanta 7100 that allows a phone to monitor the status of other phones, 
park zones, system modes, and mailboxes for users, ring groups, and the operator group. In this case the 
AdvaTel PhoneEasy IP Console software acts as a SIP soft phone. 

If the PhoneEasy IP Console is being used to monitor park zones, voice mailboxes, or 
system modes, you must configure the NetVanta 7100 to use special prefix (SPRE) codes for 
extensible markup language (XML) entities in SIP Notify messages. This must also be 
performed if the PhoneEasy IP Console is being used in conjunction with an ADTRAN 
phone. For more information, refer to Setting the SIP Notify Messages Format Using the 
CLI on page 13.
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Connecting to the NetVanta 7100

1. Open a new page in your Internet browser.
2. Enter your NetVanta 7100’s IP address in the browser’s address field in the following form:  

http://<ip address>/admin, for example: http://10.22.100.77/admin.
3. At the prompt, enter your User name and Password and select OK.

Figure 3.  GUI Login Prompt 

The default user name is admin, and the default password is password.
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Creating a Status Group

1. From the main GUI menu, navigate to Voice > Applications > Status Groups.
2. Enter a name for the new status group and select Add New Status Group. 

Figure 4.  Status Groups Menu

3. Once the new status group is created the Status Group Details Menu will be displayed. From this menu 
the status group can be configured.

Figure 5.  Status Group Details Menu
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Adding Users to Status Groups

1. From the Status Group Details Menu (see Figure 5 on page 7), select Add User.
2. Choose which users to monitor by selecting the check box next to their name (see Figure 6 below). 
3. Specify whether to identify the user in the status group by name or extension in the Phone Display 

Name field. This setting can be modified later, if needed. 
4. Select Apply to accept the changes and return to the Status Group details menu.

Figure 6.  Add Users to Status Group Menu
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Adding Park Zones to Status Groups

1. From the Status Group Details Menu (see Figure 5 on page 7), select Add Park Zone.
2. Choose which park zones to monitor by selecting the check box next to the zone (see Figure 7 below). 
3. Select Apply to accept the changes and return to the Status Group details menu.

Figure 7.  Add Park Zones to Status Group Menu

Adding System Modes to Status Groups

1. From the Status Group Details Menu (see Figure 5 on page 7), select Add System Mode.
2. Choose which system modes to monitor (see Figure 8 below). 
3. Select Apply to accept the changes and return to the Status Group details menu.

Figure 8.  Add System Modes to Status Group
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Adding Voice Mailboxes to Status Groups

1. From the Status Group Details Menu (see Figure 5 on page 7), select Add Mailbox.
2. Choose the mailbox to monitor by selecting the check box next to the mailbox (see Figure 9 below). 
3. Select Apply to accept the changes and return to the Status Group details menu. 

Figure 9.  Add Voicemail Mailboxes to Status Group Menu
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Configure the Status Group in the PhoneEasy IP Console software
Once the status group is configured on the NetVanta 7100, the PhoneEasy IP Console software must be 
directed to the status group (see Figure 10 below).

In the PhoneEasy IP Console, navigate to Tools > Options from the top menu bar to access the SIP 
Settings menu. Scroll to the Resource List field. Enter the status group name and NetVanta 7100 IP 
address (VLAN 1). Enter the information in the following format:  
<status group name>@<NetVanta 7100 IP address>, for example: receptionist@10.10.10.1

Figure 10.  SIP Settings Menu

Configure Optional Status Group Settings
The early notification feature allows all members of a status group to be notified when a member phone is 
ringing or the member is on an active call. The PhoneEasy IP Console software will display a flashing light 
when a member’s phone is ringing and a solid light when a member’s phone is busy. The early notification 
feature can be set in either the GUI or the CLI. Refer to Setting Early Notification Using the GUI on page 
12 for more information.

If the PhoneEasy IP Console is being used to monitor park zones, voice mailboxes, or system modes, you 
must configure the NetVanta 7100 to use SPRE codes for XML entities in SIP Notify messages. This must 
also be performed if the PhoneEasy IP Console is being used in conjunction with an ADTRAN phone. This 
feature can only be enabled in the CLI. Refer to Setting the SIP Notify Messages Format Using the CLI on 
page 13 for more information.
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Setting Early Notification Using the GUI

To set early notification using the GUI, log into the NetVanta 7100 unit using the procedure outlined in 
Connecting to the NetVanta 7100 on page 6. Once you have logged on to the unit and have navigated to the 
Status Groups Menu, follow these steps:

1. From the Status Groups menu, select the appropriate status group.

Figure 11.  Status Groups Menu

2. Select Early from the drop-down menu in the Group Status field.

Figure 12.  Group Status Field

3. Select Apply to accept the change and return to the Status Group menu.
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Setting the SIP Notify Messages Format Using the CLI

If the PhoneEasy IP Console is being used to monitor park zones, voice mailboxes, or system modes, you 
must configure the NetVanta 7100 to use SPRE codes for XML entities in SIP Notify messages using the 
use-spre-entities command. Additionally, this must be performed if the PhoneEasy IP Console is being 
used in conjunction with an ADTRAN phone. The use-spre-entities command can only be set using the 
CLI.

To login to the CLI and set the use-spre-entities command, follow these steps:

1. Telnet to the unit (telnet <ip address>), for example: telnet 10.10.10.1.

2. Enter your user name and password at the prompt.

3. Enter the Enable mode by entering enable at the prompt as follows:
      >enable
4. Enter your Enable mode password at the prompt.
5. Enter the Global Configuration mode as follows:
     #configure terminal

6. Enter the configuration mode for the desired status group:
(config) voice status-group receptionist

7. Change the format of the SIP notify messages by setting the use-spre-entities command:
(config status-receptionist) use-spre-entities

Special Configurations for NetVanta BCS
The PhoneEasy IP Console only requires the standard configuration steps for a SIP user in NetVanta BCS. 
For instructions on how to configure a SIP user in NetVanta BCS, Please refer to Configuring the NetVanta 
Business Communication System available from http://supportforums.adtran.com.

If during the unit’s setup process you have changed the default IP address (10.10.10.1), 
use the configured IP address.

The AOS default user name is admin and the default password is password. If your 
product no longer has the default user name and password, contact your system 
administrator for the appropriate user name and password.

https://supportforums.adtran.com/docs/DOC-4391
https://supportforums.adtran.com/docs/DOC-4391
https://supportforums.adtran.com
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Optional Advanced Configurations
This section provides optional, advanced configurations. These advanced configurations are not necessary 
for the operation of the PhoneEasy IP Console with either the NetVanta 7100 (standalone) or NetVanta 
BCS; however, they enhance the capabilities of the integration. These instructions refer to other sections in 
this guide and other ADTRAN documentation where necessary. This section contains the following 
subsections:

• Monitoring a Park Zone on the NetVanta 7100 Using a BLF on page 14
• Monitoring a Voice Mailbox on the NetVanta 7100 Using a BLF on page 14
• Monitoring the User’s Mailbox on the NetVanta 7100 Using a BLF on page 15
• Monitoring the NetVanta 7100 System Mode Using a BLF on page 15
• Configuring Ringing Call Pickup on page 16
• Populating the PhoneEasy IP Console’s Internal Directory on page 16

Monitoring a Park Zone on the NetVanta 7100 Using a BLF

The steps below outline park zone BLF configuration for the PhoneEasy IP Console. For more information 
on configuring status groups, refer to Configuring Status Groups in the NetVanta 7100 available from 
http://supportforums.adtran.com.

1. Create a unique status group on the NetVanta 7100 for monitoring from the PhoneEasy IP Console. For 
more information on configuring a status group, refer to Create and Configure a Status Group on the 
NetVanta 7100 on page 5.

2. From the NetVanta 7100 GUI, use the Add Park Zone button from the Status Group configuration 
menu to add a park zone to the status group. For mo.?re information on adding a park zone, refer to 
Adding Park Zones to Status Groups on page 9.

3. From the NetVanta 7100 CLI, enter use-spre-entities command from the Voice Status Group 
Configuration mode on the NetVanta 7100. For more information, refer to Setting the SIP Notify 
Messages Format Using the CLI on page 13.

4. In the PhoneEasy IP Console, create entries in the internal directory for parking and retrieving. For 
example, create *771 for parking a call in park zone 1 and *781 for retrieving a call from park zone 1. 

5. In the PhoneEasy IP Console, the internal directory park entry should now be assigned to a My 
WorkGroup button. The My WorkGroup button will operate like a BLF and will light when a call is 
parked on it.

Monitoring a Voice Mailbox on the NetVanta 7100 Using a BLF

The steps below outline voice mailbox BLF configuration for the PhoneEasy IP Console. For more 
information on configuring status groups, refer to Configuring Status Groups in the NetVanta 7100 
available from http://supportforums.adtran.com.

1. Create a unique status group on the NetVanta 7100 for monitoring from the PhoneEasy IP Console. For 
more information on configuring a status group, refer to Create and Configure a Status Group on the 
NetVanta 7100 on page 5.

https://supportforums.adtran.com/docs/DOC-2260
https://supportforums.adtran.com
https://supportforums.adtran.com/docs/DOC-2260
https://supportforums.adtran.com
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2. From the NetVanta 7100 GUI, use the Add Mailbox button from the Status Group configuration menu 
to add a park zone to the status group. For more information on adding a park zone, refer to Adding 
Users to Status Groups on page 8.

3. From the NetVanta 7100 CLI, enter use-spre-entities command from the Voice Status Group 
Configuration mode on the NetVanta 7100. For more information, refer to Setting the SIP Notify 
Messages Format Using the CLI on page 13.

4. In the PhoneEasy IP Console, create a voicemail entry in the internal directory using the format 
*98XXXX, where XXXX is the extension of the voice mailbox you would like to monitor. 

5. In the PhoneEasy IP Console, the internal directory voice mailbox entry should now be assigned to a 
My WorkGroup button. The My WorkGroup button will operate like a BLF and will light when an 
unread message is in the mailbox.

Monitoring the User’s Mailbox on the NetVanta 7100 Using a BLF

The method in Monitoring a Voice Mailbox on the NetVanta 7100 Using a BLF on page 14 can be used to 
monitor any mailbox; however, one of the eight FlexKeys to the right of the active call pane in the 
PhoneEasy IP Console can be used to monitor the status of the mailbox and used as a speed dial for the 
mailbox.

Monitoring the NetVanta 7100 System Mode Using a BLF

The steps below outline system mode BLF configuration for the PhoneEasy IP Console. For more 
information on configuring status groups, refer to Configuring Status Groups in the NetVanta 7100 
available from http://supportforums.adtran.com.

1. Create a unique status group on the NetVanta 7100 for monitoring from the PhoneEasy IP Console. For 
more information on configuring a status group, refer to Create and Configure a Status Group on the 
NetVanta 7100 on page 5.

2. From the NetVanta 7100 GUI, use the Add Mailbox button from the Status Group configuration menu 
to add a park zone to the status group. For more information on adding a park zone, refer to Adding Park 
Zones to Status Groups on page 9.

3. From the NetVanta 7100 CLI, enter use-spre-entities command from the Voice Status Group 
Configuration mode on the NetVanta 7100.

4. In the PhoneEasy IP Console, create a system mode entry in the internal directory using the format 
*20N, where N is the system mode number. 0 is the Default system mode, 1 is the Night system mode, 
2 is the Weekend system mode, 3 is the Lunch system mode, for example: *201 specifies the Night 
system mode. 

5. In the PhoneEasy IP Console, the internal directory paging group entry can now be assigned to a My 
WorkGroup button. The My WorkGroup button will operate like a BLF and will light when a page is 
initiated.

https://supportforums.adtran.com/docs/DOC-2260
https://supportforums.adtran.com
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Configuring Ringing Call Pickup

The call pickup feature allows users to pick up a call ringing on other extensions without having to park the 
call. The steps below outline ringing call pickup configuration for the PhoneEasy IP Console. 

1. From the NetVanta 7100 GUI, create and configure a class of service (CoS) for the PhoneEasy IP 
Console extension.
a. Navigate to Voice > System Setup > Classes of Service. The Classes of Service menu will appear.
b. In the Classes of Service menu, select one of the undefined CoS links to define a new CoS. The 

Configure New Class of Service menu will appear.
c. In the Configure New Class of Service menu, configure the CoS for the PhoneEasy IP Console. For 

more information on configuring a CoS, refer to Configuring NetVanta 7100 Class of Service 
available from https://supportforums.adtran.com.

d. In the Configure New Class of Service menu, expand the Advanced Permitted Actions section, 
and use the Pickup Extension check box to enable call pickup functionality for calls placed to 
another extension. This allows the PhoneEasy IP Console user to pick up a ringing call for another 
user.

e. Select the Apply button.
2. From the NetVanta 7100 GUI, assign the PhoneEasy IP Console user to the CoS created in Step 1.

a. Navigate to Voice > System Setup > Classes of Service. The Classes of Service menu will appear.
b. In the Classes of Service menu, select the number in the User Assigned column associated with the 

CoS created in Step 1. If the CoS has no members assigned to it, the number in the Users Assigned 
should be 0. The Class of Service Members menu will appear.

c. In the Class of Service Members menu, select the Add Members button. The Add Users to Class 
of Service menu will appear.

d. In the Add Users to Class of Service menu, use the check box in the Add? column to add the 
PhoneEasy IP Console user. Select the Add Selected Users button. The PhoneEasy IP Console user 
will be added to the CoS.

Populating the PhoneEasy IP Console’s Internal Directory

The best way to populate the internal directory is to import a CSV file with the user name and extension 
number information into the PhoneEasy IP Console. CSV files can be created using a spreadsheet program 
like Microsoft Excel. Because the PhoneEasy IP Console does not check for duplicate entries when 
importing contacts, all duplicates should be removed from the CSV file prior to importing.

Operating the PhoneEasy IP Console
This section provides information on performing basic call transfers on the PhoneEasy IP Console. It 
consists of the following subsections:

• Performing a Blind Transfer on page 17
• Performing an Unattended Transfer on page 17
• Performing a Quick Transfer to Voicemail on page 17

https://supportforums.adtran.com/docs/DOC-2255
https://supportforums.adtran.com
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Performing a Blind Transfer

The easiest way to perform a blind transfer is to drag and drop the call from the Active Call area onto a 
contact in the Internal directory or My Workgroup.

Performing an Unattended Transfer

To perform an unattended transfer in the PhoneEasy IP Console, follow these steps:

1. In the PhoneEasy IP Console, drag and drop a contact from the Internal directory or My Workgroup 
area to the Active Call area. A new call will be set up with the contact.

2. Once the destination contact answers press the Transfer button to complete the transfer.

Performing a Quick Transfer to Voicemail

To perform a quick transfer to voicemail in the PhoneEasy IP Console, follow these steps:

1. In the PhoneEasy IP Console, right-click the target contact in the Internal directory or My Workgroup 
area.

2. Select Transfer to Voicemail. This will transfer the currently active call to the voicemail of the 
extension selected without ringing the extension.
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Integration Best Practices
The following sections provide best practices for integrating and operating the PhoneEasy IP Console with 
the NetVanta 7100 (standalone) and NetVanta BCS. 

Best Configuration Practices 

The following are the suggested best practices for configuring the PhoneEasy IP Console and 
NetVanta 7100:

• Create a CoS on the NetVanta 7100 for exclusive use by the PhoneEasy IP Console user, so that the user 
can be given special privileges such as directed call pickup and long distance dialing. For more 
information on configuring a CoS, refer to Configuring NetVanta 7100 Class of Service available from 
https://supportforums.adtran.com.

• Place the PhoneEasy IP Console in a ring group with a hard phone on the NetVanta 7100. This will 
allow the user to receive and process calls if the computer on which PhoneEasy IP Console is installed 
is shut down or unavailable. Alternatively, call coverage can be used to forward all unanswered calls to 
another extension, call queue, or voicemail. For more information on configuring ring groups, refer to 
Configuring NetVanta 7100 Ring Groups available from https://supportforums.adtran.com.

• Create a unique call pickup group on the NetVanta 7100 for users whose ringing calls can be answered 
by the PhoneEasy IP Console user. This allows ringing calls to be picked up by the operator by dialing 
the call pickup group extension or using a soft key assigned to that extension. For more information on 
configuring call pickup groups on the NetVanta 7100, refer to Configuring Call Pickup Groups on the 
NetVanta 7100 available from http://supportforums.adtran.com. 

• In the PhoneEasy IP Console, navigate to Tools > Options > Call Settings and ensure that 
VM_CHECK* is entered in the Transfer to Voicemail Prefix field. This allows the user to perform a 
quick transfer to voicemail.

• Create a login password to protect access to the PhoneEasy IP Console. The password can be set by 
navigating to File > Set Password in the menu bar.

• Because PhoneEasy IP Console does not check for duplicate entries when importing contacts with a 
CSV file, duplicates should be removed from the source file before importing contacts.

Best Operation Practices for PhoneEasy IP Console

The following are the suggested best practices for operating the PhoneEasy IP Console:

• If Microsoft Outlook integration is being used with the PhoneEasy IP Console, start the Outlook client 
before starting the PhoneEasy IP Console.

• Do not close the PhoneEasy IP Console while calls are active or on hold. The PhoneEasy IP Console 
will wait for the active or held calls to clear before closing, possibly requiring you to force the 
PhoneEasy IP Console to close using the Windows Task Manager.

• Use My Workgroup keys, not FlexKeys, to park and retrieve calls. This allows the BLF status of the 
park zone to be monitored using the My Workgroup key.

https://supportforums.adtran.com/docs/DOC-2255
https://supportforums.adtran.com
https://supportforums.adtran.com/docs/DOC-2276
https://supportforums.adtran.com
https://supportforums.adtran.com/docs/DOC-2337
https://supportforums.adtran.com/docs/DOC-2337
https://supportforums.adtran.com
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